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Introduction 
EZ Tag allows creation of PDF variable data tags (FDF) from Elixir form files. 
EZ Tag is a purchasable option from Elixir Technlogies that allows conversion of 
any Elixir form file to Adobe PDF with fillable FDF fields and is available with 
Elixir Applications Suite 4.10q+.   

These PDF files could be presented on a website using an Internet Browser, 
combined with a system for extracting the filled data, or for online data entry 
using the free Acrobat Reader (Version 5+) for local printing 
(www.adobe.com/products/acrobat).    

Using the DataTag function within any ElixiForm product or the ElixiTag utility 
for Windows applications, you can convert the existing Elixir Form files with 
tags or create new tags in forms ready to be  converted to Adobe PDF.  

This document describes adding tags using Elixir form products (DataTags) or 
adding tags to Windows applications (ElixiTag) and converting these tags to PDF 
format using the Elixir Desktop products. 

Note:  DataTags for use with Elixir DocuTag and DataMerge are fully described 
in their respective User Guides, although the tags prepared for these products can 
be used with EZ Tag. 

Adding tags 

When creating new documents, you can add and/or modify data tags within your 
Windows application using ElixiTag and convert these Windows applications to 
Elixir form format using any of the Elixir PrintDriver products, or use any 
ElixirForm product to add DataTags.   

The options for ElixiTag (Windows applications converted to Elixir forms) or for 
creating  DataTags (Elixir form function) are the same and only those options 
required by EZ Tag are described in this document. 
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Using ElixiTag 

ElixiTag is provided with Elixir DataMerge or Elixir DocuTag products and EZ 
Tag when the option is purchased.  

To use ElixiTag to create data tags: 

1. Start Programs>Elixir>ElxTag. 
 
The ElixiTag dialog box displays. 

 

Figure 1 - ElixiTag dialog 
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2. Select the options for each tag and convert the document to Elixir format 
using any of the Elixir PrintDriver products. 
 
Note: Refer to your Elixir PrintDriver User Guide for instructions on 
how to convert a Windows application document to Elixir form files. 

3. Convert the Elixir form files to PDF format using the Elixir Desktop 
product by checking [Include EZ Tag] from the PDF settings dialog. 

Using DataTag 

1. Open your Elixir Form product and select the Text Tool. 

2. Select the DataTagging option from the  Text Tool options, as shown 
below. 

 

Figure 2 - Text Tool 

3. Click the cursor in the work area where the DataTag should be 
positioned. 



 

_________________________________________________________ 
EZ Tag User Guide 5 
 

 
The Data Tagging dialog displays. 

 

Figure 3 - Data Tagging Dialog 

4. Select the options for each DataTag: 

5. Select the text attributes for the field, such as font, point size etc., before 
adding the data tag to the form or right-click on the data tag after it has 
been created to access the [Modify Text Properties] option. 

6. Save the form. 
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Options for ElixiTag and DataTag 

ElixiTag and DataTag were created for use with Elixir DocuTag or Elixir 
DataMerge and can be also be used to define tags for EZ Tag. Only those options 
required for EZ Tag are described in this section. 

File (ElixiTag only) 

The File menu options include: 

• [Open] - open a tag list file 

• [Save] and [Save As] - save the file 

• [Exit] - exit ElixiTag. 

Help (ElixiTag only) 

The Help menu options include: 

• [Help on Current Field] - field where the cursor displays 

• [Help on ElixiTag] - within the displayed dialog box, click on any option 
that changes the cursor to a hand for a description of that option 

• [Customer Support] - provides phone numbers for problem resolution 
and training information 

• [About] - how ElixiTag works with DocuTag. 

Search by Name (ElixiTag only) 

This field allows you to search by field name in your tag list file to display the 
associated tag attributes. 
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Number (ElixiTag (editable) and DataTag (generated)) 

Select or enter the number of the field.  As you add tags, ElixiTag automatically 
increments default field numbers unless you enter a field number.  The default 
numbers are sequential and start at 01.  The largest field number allowed is 700. 

Name (ElixiTag and DataTag) 

Enter the name of the variable data field.  The maximum allowable field name 
length is 30 characters.  

Naming Convention to be used with EZTag 

It is recommended that you use fixed pitch fonts for FDF fields so that the 
borders and field contents match. Tagnames are restricted to 32 characters in 
length. 

If the tag name is prefixed with: 

• $_ 
The FDF field will display data entered as right justified (default) 
punctuated at thousands, with two decimal places.For example 2004.28 
will be displayed in the field as $2,004.28.  To change the default 
jusfication see the section, Changing the Default Justification 

• #_ 
The FDF field will display data entered as left justfiied (default) 
punctuated at thousands, with two decimal places. For example 2004.28 
will be displayed in the field as 2,004.28. To change the default 
jusfication see the section, Changing the Default Justification. 

• BORDER_ 
The FDF field in the PDF file will be surrounded by a border . The 
border color is controlled by the setting in the PDF.txt definition file.  
Valid colors for borders are black (default), red, green or blue. 

• CHECK_  
The FDF field in the PDF file will display an empty box . When the user 
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selects the checkbox  the  character will display.  It is recommended 
that the [Field Length] is seet to at least two characters. 

• CHECKB_ 
The FDF field in the PDF file will display an empty box surrounded by a 
border. It is recommended that the [Field Length] is set to at least two 
characters.  The border color is controlled by the setting in the PDF.txt 
definition file.  Valid colors for borders are black (default), red, green or 
blue. 

• COMPLETE 
Reserved keyword. 

• DEFAULT_tagname 
Will display the string added to the comment field as the default text in 
the FDF field.  The FDF field can be edited to replace the default text 
when viewing the PDF document. 

• DIFF_tagname 
Will display the sum of subtracting the fields listed in the Comment 
field, the FDF field will be right justified and punctuated at thousands 
with two decimal places. 

• DIFF$_ tagname 
Will display the sum of subtracting the fields listed in the Comment 
field, the FDF field will be formatted as US dollar currency, right 
justified and punctuated at thousands with two decimal places. 

• DROP_ tagname 
The FDF field in the PDF file will display the list of entries entered in 
the comment field as a dropdown selectable list. 
 
See the Comment field for adding entries to be used by a dropdown 
selection. 

• DROPEDIT_ tagname 
The FDF field in the PDF file will display the list of entries entered in 
the comment field as a dropdown selectable list and also allow additional 
text entry in the FDF field. 
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See the Comment field for adding entries to be used by a dropdown 
selection. 

• GRAY_ tagname  
The FDF field will be filled with a shade pattern. 

• MULT$_ tagname 
Will multiply the data entered in those fields listed in the Comment field 
and display the result as right justified with a $ mask. 

• MULT_ tagname 
Will multiply the data entereed in those fields listed in the Comment 
field and display the result as right justified amount. 

• RADIO_ tagname 
Will display as a check box with the text associated entered in the 
comment field. A radio button represents a fixed set of choices each with 
text next to it, one of  which  must be selected.  The text entered into the 
comment field is the string that would be returned to the URL in the 
PDF.txt definition file. 

• RADIOB_ tagname 
Will display a radio check box with a border.  The text associated with 
the radio button should be entered into the Comment field. 
 
This prefix should be used when borders are set to [No] in the PDF.txt 
definition file. 

• SUBMIT 
Reserved keyword. 

• SIGNATURE 
Reserved keyword. 

• TAGNAME.REQ  
This type of tag is defined as a required fillable field in the PDF file. 
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• TOTAL$_ tagname 
Will total the data entered in the fields listed in the Comment field and 
display the result with the $ mask, right justified (the default) and 
punctuated at thousands with two decimal places. To change the default 
jusfication see the section, Changing the Default Justification. 

• TOTAL_ tagname 
Will total the data entered in those fields listed in the Comment field and 
display the result as left justified (the default), using the comma separator 
and two decimal places. To change the default jusfication see the section, 
Changing the Default Justification. 

Changing the Default Justification 

You can override the default justification for a field by add the following 
extensions to the tag name: 

• Prefix_tagname.L 
Left justified field. 

• Prefix_tagname.C 
Centre justified field. 

• Prefix_tagname.R 
Right justified field.  

Length (ElixiTag and DataTag) 

Enter the maximum number of characters allowable in the specified field. 

Replacement Char(acter) (ElixiTag and DataTag) 

Variable data fields display in the windows application document or the Elixir 
form as a string of replacement characters.  The replacement character is usually 
a @, !, #, or " character.  When you click on [Add New Tag], ElixiTag 
automatically rotates the replacement character.  Enter the character, if different 
from that displayed, to be used for the new tag. 

Note:  Replacement characters should not be characters used in the text data. 
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Mandatory (ElixiTag and DataTag) 

Reserved for DocuTag.  See your DocuTag User Guide for a detailed description. 

Delete After Use (ElixiTag and DataTag) 

Reserved for DocuTag.  See your DocuTag User Guide for a detailed description. 

Field End (ElixiTag and DataTag) 

Reserved for DocuTag.  See your DocuTag User Guide for a detailed description. 

Multi-Data (ElixiTag and DataTag) 

Reserved for DocuTag.  See your DocuTag User Guide for a detailed description. 

Align (ElixiTag and DataTag) 

Reserved for DocuTag.  See your DocuTag User Guide for a detailed description. 

Depth (ElixiTag and DataTag) 

Enter the number of lines in the specified variable data field.  The default is 01. 

Field Gen (ElixiTag and DataTag) 

This option allows you to include non-replacement characters in the middle of a 
string of replacement characters.  This is useful when formatting date fields or 
telephone numbers.  For example, to separate the month, day, and year in the date 
field with slashes, type **/**/** (where * is the replacement character you 
specified). 

To print the telephone number, you can type (***)***-**** (where * is the 
replacement character you specified). 

Enter the non-replacement characters as you want them to display in relation to 
the replacement characters.  Maximum field length is 30 characters. 
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Comment (EZTag, ElixiTag and DataTag) 

For EZTag the comment field is used when the field prefix for DROP_, 
DROPEDIT, TOTAL$, MULT, or MULT$ is used or as help text that will 
display when the cursor is passed over FDF fields in the PDF document.  You 
must separate values or field names in the comment field by a space character, 
e.g. Texas California New Mexico etc. 

Scroll by Number (ElixiTag only) 

You can scroll through the pre-defined tag list one tag at a time or press and drag 
the scroll box to move forward or backward in the tag list. 

Add New Tag (ElixiTag only) 

Once you define a tag other than one that is in the list, use this option to add it to 
the list for re-use.  This saves the tag to your drive:\ELIXIR\DTTAGS.TAG file. 

Delete Tag (ElixiTag only) 

This option deletes the selected tag from your drive:\ELIXIR\DTTAGS.TAG 
file. 

Copy (ElixiTag only) 

This option copies the tag information to your Clipboard.  Once you return to 
your Windows application, you can paste the tag from the Clipboard into your 
document. 

Click on [Copy] to copy the data tag information to the Clipboard. 

Open your  Windows application and place the cursor on the form where you 
want the data tag to print. 

From the Edit menu, select [Paste].  The tag with replacement characters displays 
in the document. 
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Note:  Once you have pasted a data tag into your document, you cannot edit it.  
You must delete the tag and  create a new tag. 

Existing Elixir Forms 

Using the utility MAKECHKB.exe provided with EZTag existing Elixir form 
files (*.elx) that contain checkboxes defined using special font characters can be 
converted to CHECKB_ without having to add new datatags. 
 
Usage: 
 
MAKECHKB FILENAME SEARCHCHAR [WIDTH] 
 
Where: 
MAKECHKB 
Is the utility stored in your drive:\ELIXIR folder. 
 
FILENAME 
Is the name of the Elixir form file(s) to be converted.  The path should be 
included in the filename and wildcards can be used. 
 
SEARCHCHAR  
Is the character in the existing Elixir form that will be converted into an FDF 
field. As an example the character ‘b’ will be converted 
 
[WIDTH] 
Is the optional width of the FDF CHECKB_ field.  It is recommended that 
checkboxes have a length of at least two characters. 

 
Creating  the definition file for EZTag 

The default presentation of the FDF fields for position, font and field length are 
controlled by the field defined in the Elixir form.  A definition file can be created 
to define the following: 

• Position on the PDF file and the URL where the file will be sent when 
the [SUBMIT] button has been activated. 
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• Border, Border color and border fill for the FDF field 

To create a definition file: 

Create an ASCII text file in DRIVE:\ELIXIR\PDF.txt with those entries required 
for PDF conversion.  A sample PDF.txt file is displayed below for your 
reference. 
 
SUBMITURL=http://XXX.XXX.X.XXX/name.asp 
SUBMITPOS=1,1,300,75 
COMPLETEPOS=300,1,600,75 
BORDERS=YES 
BORDERCOLOR=RED 
DODEFAULTS=NO 
TEXTCOLOR=GREEN 
SORTBYTAGNUMBER=YES 
SUBMITTYPE=HTML 
SCROLLING=NO 
 
where: 
 
Submiturl 
Has the ip address and active server page where the PDF file with the FDF fields 
will be submitted when the [Submit] button is activated on the PDF file. 
 
Submitpos 
The [Submit] box position on the output PDF file.  The co-ordinates are top left 
x, top right x, bottom left x, and bottom x right in dots per inch.  All forms will 
have this field added. 
 
Completepos 
This is reserved for workflow systems and indicates if the form is complete. 
 
Bordercolor 
Definition of the color of the FDF field border. [Black] (default), [Red], [Green], 
or [Blue].  



 

_________________________________________________________ 
EZ Tag User Guide 15 
 

Borders 
Definition for displaying field borders or field fill. [No] (default).  Selecting 
[Yes] will display a border around each field.  Selecting [Gray] will display the 
borders with a shade pattern. 

Dodefaults 
Definition for default entries in each FDF field.  Selecting [Yes] will use the 
entry in the Comment field as the default filled string for the FDF field. 

Textcolor 
The color that text will be displayed when entered into FDF fields. [Black] 
(default), [Red], [Green], or [Blue].  

Scrolling 
Definition for fillable fields to allow scrolling of text entered.  Fillable FDF fields 
that are destined for printing should have this option set to [No].  The default, 
[YES] will allow scrolling of the field entry and when printed will only print the 
text that is displayed and not the full entry.  

Sortbytagnumber 
Sorts the FDF fields in the PDF file when the TAB key is used. [YES], will set 
the order of the fillable FDF fields in the PDF file using the [Field Number] in 
the Data Tagging options dialog box for the Elixir form. 

[NO], the default.  The tab order will be sequenced from the top of the PDF file 
to the bottom of the PDF file.  

Submittype 
[HTML] the default, only the data entered in the presented PDF file. 
[COMPLETE], saves the data and the complete PDF file. 

Generating Adobe PDF files with FDF fields 

Converting the Elixir Form files (.ELX) to PDF format with FDF tag files is 
achieved using any of the Elixir Desktop products base release 4.10q+ when an 
EZ Tag Option is purchased.   

To convert to PDF: 
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1. Launch your Elixir Desktop product. 

2. Select the forms for conversion to PDF and drag and drop into the Converter 
icon, or <Ctrl> +<V>. 
 
The Form Converter Options displays. 

 
Figure 4 - Form Converter Options Dialog 

3. Select [PDF] and then [OK]. 
 
The PDF Settings dialog displays. 
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Figure 5 - PDF Settings Dialog 

4. Select the [Output PDF Directory] where the PDF files will be stored and the 
Output PDF file name if different from the Elixir file name. 

5. Select the [Font Settings] option to be used for the output PDF file: 
 
[Substitute All Fonts (MM Fonts)] 
Substitutes the original fonts in the Elixir form file to Adobe Multiple Master 
versions of all fonts in job.  This option will significantly reduce the size of 
the output PDF file if Elixir Raster fonts were used.  The font representation 
in the output PDF file will be simulate the typeface used, preserving the line 
endings of the original file. 
 
[Rasterize All Fonts (type3 Fonts)] 
All fonts used in the Elixir file will be embedded as Type3 raster fonts in the 
output PDF file.  This will preserve the fidelity of the original file and fonts 
used.  This will increase the size of the PDF file significantly. 
 
[Use Font Mapping]: 
Select to use a mapping table to control, on a font-by-font basis, the font 
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format used in the PDF file. When you use this method, you can use a 
combination of Multiple Master, Adobe Type 3 raster fonts and Adobe Type 
1 (PostScript) name mappings for the fonts in your document. The mapping 
table will also allow you to rasterize images used in the Elixir form file.  
 
Enter the mapping file to use in the text box adjacent to this option. 
Default is drive:\ELIXIR\PSSTASH\PSFONTS.MAP. 
 
When you select this option, the Elixir Desktop Application scans the 
specified file and compares Elixir font names in the document with the 
names found in the mapping file (see example below). If a match is found, 
the Elixir Desktop looks at the right half of the entry to determine whether to 
rasterize as a Type 3 font or call the font out by a Type 1 name. If a match 
for a particular font is not found, a Multiple Master instance is generated. 
 
The mapping file is a text file with a simple equivalence table, which you can 
edit. The syntax for the entries is: 
 
font name= [RASTERIZE] [TYPE1fontname-weight point-size] 
 
For example: 
 
TR11NP=Times-Roman 11 
TR12NP=Times-Roman 12 
HE07BP=Helvetica-Bold 7 
CH14SP=ZapfChancery-MediumItalic 14 
SIGFNT=RASTERIZE 
 
If you specify a Type 1 font name, you must enter it exactly as it appears in 
the Installed ATM Fonts dialog box in the Adobe Type Manager. If you want 
to view the resulting PDF file on another workstation, the font must be 
available through ATM on that target machine. 

6. Select the [KMP Map Table] to be used for the conversion.  The default is 
drive:\ELIXIR\FONTS\MAPS\X100ANSI.KMP. 
 
Select the KMP table from the drop-down list to be used for mapping 
characters into the correct positions for the Windows character set. You can 
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either select from the supplied list of KMP files, please refer to your Desktop 
or Form Editor User Guide for the list of supplied Keyboard Mapping files, 
or you can create your own keyboard mapping table.   
 
The KMP file is an ASCII file that consists of two columns: 
 
PostscriptCharacterName  = Hexidecimalvalue 
 
where: 
 
Postscriptcharactername 
Is the name of each character in a font set. 
 
Hexidecimalvalue 
Is where the Postscript character will be mapped to in the output PDF.   
 
The most common edits to a KMP file are mapping the Left Double 
Quotation Mark or Right Double Quotation Mark for the Quotation Mark. 

7. Check [Include EZ Tags], then [OK]. 

8. The Form Conversion Status dialog will display showing the status of the 
conversion. 
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Figure 6 - Form Conversion Status 

 
The PDF files will be converted and stored in the output forms directory for PDF 
files.  These files can be viewed by Acrobat Reader (Version 5+). 


